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PSoC® Creator™ Release Notes 
Version 3.1, Component Pack 1 

This release is PSoC Creator 3.1, Component Pack 1, which provides an updated Bluetooth Low Energy 
(BLE) component. If PSoC Creator 3.1 is already installed on your machine, only the updated component 
will be installed. Otherwise, the complete release will be installed. 

This release addresses a BLE device issue that results in unreliable connections and provides a 
workaround that allows the chip to function correctly. If you have experienced difficulties with 
BLE advertising and connection loss, we strongly recommend installing this software and 
updating the BLE component version in your projects. See BLE Component under "Defects Fixed" 
for more information. 

PSoC Creator 3.1 is an upgrade from the 3.0 Service Pack 2 (SP2) release. It adds the following features: 
 BLE Part Support 
 Updated Code Editor 
 New Project "Save As" Capability 
 Improved Schematic Rubber-Banding 
 Superset Part Programming for use with Development Kits 
 Static Library Support for Components 

This release does not replace existing installations of PSoC Creator (e.g., 3.0 or 2.2); it installs alongside 
them. This enables you to move designs to the new version at your own pace. We guarantee that your 
existing designs can be opened in the new software, but please upgrade your components to the latest 
version. To ensure that you can always return to your previous setup, a backup of your project is 
automatically created when opening a project in a new version of the tool. It is stored in a folder named 
"backup" in the project’s folder. 

This document describes general software features and changes since the PSoC Creator 3.0 SP2 
release. 

If you have technical questions, visit www.cypress.com/go/support or call 1-800-541-4736 and select 8. 
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PSoC Creator 3.1 Component Pack 1 Contents 

The BLE component was updated to version 1.10. This component was updated to fix a BLE RF link 
(transmit/receive) defect observed on some devices. The fix increases the Rx current by ~0.3 mA to 
ensure connections can be reliably made and maintained. 

New Features in PSoC Creator 3.1 

BLE Part Support 

With this release, PSoC Creator now supports Cypress’s BLE devices: PSoC 4100 BLE, PSoC 4200 BLE 
and PRoC BLE. 
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Updated Code Editor 
In general, autocomplete in PSoC Creator is smarter and faster. The code editor provided in PSoC 
Creator 3.0 has been updated with new autocomplete features: 

 option to change tab key behavior 
 new feature to match characters in the middle of strings 
 option to control visibility of macros 
 hot-key to show/hide macros 

In addition, "Find All Active References" is faster and reports results in a separate window. 

Note If you run PSoC Creator on a virtual machine and access source files from a shared folder, you 
must disable Semantic Parsing using the Tools > Options > Semantic Parsing menu item. There is a 
known issue with a third-party tool that is used to support the Semantic Parsing features. For more 
information, refer to the bug report for that tool (http://llvm.org/bugs/show_bug.cgi?id=21143). 

Superset Part Programming 
Because Cypress does not build development kits for every single device, this feature enables the 
programming/debugging of hex images for compatible parts of the same family. 

The Select Debug Target dialog has been updated to show and select a compatible device. 

 

Static Library Support for Components 

PSoC Creator component support has been extended so that libraries can be added to the 
implementation of a component. Different libraries may be provided for compiler tool-chains and 
configurations (DEBUG/RELEASE). This helps component developers in two ways: 
 Allows developers to use the standard PSoC Creator component development flow (that is, not 

shipping a library as an extra piece) without having to provide source code for the whole software 
package. 

 By shipping the source code in a library, it allows component authors to avoid slowing down builds of 
projects that use their content. 

Project "Save As" Capability 
The new project "Save As" feature is more intuitive. In PSoC Creator 3.1, the "Save As" option launches a 
dialog that enables you to choose a new project name and location. 

Updated Rubber-Banding 
The Rubber-Banding feature implemented in the previous release was somewhat restrictive in allowing 
various moves. In this release, the underlying algorithms have been updated to allow the moving process 
to flow more smoothly and fail less often. 

http://llvm.org/bugs/show_bug.cgi?id=21143
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Components and Example Projects 
This section contains information about new and updated components in this release. Refer to the 
applicable component datasheets (available in the PSoC Creator distribution and on the web) for 
additional information. 

New Component 

The following new component has been added as part of this release: 
 Bluetooth Low Energy (BLE) – This component provides a comprehensive GUI-based configuration 

window to quickly design applications requiring BLE connectivity. 

Updated Components 
The following components have been updated in this release: 

 ADC_SAR_SEQ_P4 2.0   Bootloader/Bootloadable 1.30   CapSense_CSD_P4 2.10 

 CapSense_Gesture P4 2.10  CharLCD 2.10   Comp_P4 1.10  

 cy_boot 4.20  I2C LCD 1.20   I2S 2.60  

 LPComp_P4 2.0  OpAmp_P4 1.10   Pins 2.10  

 PWM 3.10  SCB_P4 2.0   SegLCD_P4 1.10  

 TCPWM_P4 2.0   DVDAC 2.10   FanController 4.0  

 Filter 2.30   ILO_Trim 2.0   ScanComp 1.10  

 SMBusSlave 4.0   SW_Tx_UART 1.30   Timer 2.70  

 USBFS 2.80  Clock 2.20   cy_gsref 2.0  

 cy_UDB_clockenable 1.0   CyStatusReg 1.80   DFB 1.30  

 DieTemp_P4 1.0   DMA 1.70   EZI2C 1.90  

 FanController 3.10   IDAC_P4 1.0   IDAC8 2.0  

 ILO_Trim 1.10   Opamp 1.90   Sample_Hold 1.40  

 ThermistorCalc 1.20  ThermocoupleCalc 1.20  UART 2.31 

Updated Example Projects 
The following example projects have been updated in this release: 

 PRSExample   RTDExample  SAR_SPIM_USB 

 SCB_SpiComm  ScanCompCommonExample  SegLCD_LowPowerExample 

 Shifter_and_Library  SPDIF_Tx  SPI_Design 

 SPIM_Example  SPIS_Example  StaticSegLCD_Example 

 SW_Tx_UART_Example  ThermistorCalc_Example  ThermocoupleExample 

 Timer   UART_Rx   USB_UART  

 USBFS_Bootloader   
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Design Impact 

Changed Internal Low Speed Oscillator (ILO) Accuracy in PSoC 4100 and PSoC 4200 
devices 
The accuracy of the ILO in PSoC 4100 and PSoC 4200 devices was wrong and has been fixed. This may 
cause some clock accuracy warnings if a design placed constraints on the accuracy of the source clock. 
There is no change to silicon behavior. 

Watch Dog Timer (WDT) Usage in BLE Component 

As a temporary implementation for the beta release only, the BLE Component used Counter #2 of the 
WDT for timing support in deep-sleep mode. If you used the Counter #0 and Counter #1 in your 
application, you must share the single WDT interrupt with the BLE Component. 

In this production release of PSoC Creator 3.1, the protocol procedure timeout functionality is 
implemented using the Bluetooth Low Energy Sub-System (BLESS) Link Layer timer. Note that this 
replaces the Watchdog Timer (WDT) used in the preliminary release of the component and will require 
any design using the feature to migrate. 

Corrected heap bounds-checking in sbrk() 

The sbrk() function, which is used by malloc() and other heap-utilizing functions to check for available 
memory, has been updated to correct a prior defect. In PSoC Creator 3.0, the heap boundary was 
calculated from an erroneous assumption about the relative positions of the heap and the stack. As a 
result, it was possible for applications to be allocated SRAM beyond the heap boundary. 

The fix ensures that malloc(), et al, now correctly handle heap overflow. Note that some projects, most 
notably a small number of PSoC Creator examples from the 3.0 release, will now fail to execute due to a 
lack of available heap. The resolution is to increase the heap size in the Design-Wide Resources System 
Editor (<project>.cydwr file), and re-build the project. 

Default Stack and Heap Sizes 

The default stack and heap sizes for new projects have been adjusted to more closely match real-world 
requirements. When new projects are created, the stack size is set to be a fraction of the total SRAM in 
the target device. The heap is set to a small value - 128 bytes - for all devices. You can, of course, modify 
these settings in the Design-Wide Resources System Editor. For example, if you are not using any heap-
based memory allocation the heap can safely be set to 0 bytes. 

Note that some example projects and application notes were originally created on older versions of PSoC 
Creator and use the larger default sizes. These projects will continue to build and run perfectly because 
they have sufficient memory allocated. However, if you attempt to reproduce the example yourself in your 
own project you may need to adjust the stack and heap. However, the example documentation will not tell 
you to do that because the original project did not require the settings to be changed. 

Stepping Over Flash Write Functions 

The PSoC Creator debugger may exit or stop responding to commands when stepping over a call to the 
CySysFlashWriteRow function. This issue also affects functions that call CySysFlashWriteRow, including 
the Emulated EEPROM component's Write function. In these cases, do not step over the function. 
Instead, use the Run to Cursor command to continue execution until the function call has finished. 
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Debugger Breakpoint Failure on GCC ARM Embedded v4.8.4 Toolchain 

When a breakpoint exists in a location that is not valid, the debugger may fail to start with the message:  

"Debugger exited unexpectedly during run"  

This is an issue in the ARM GDB tool; not PSoC Creator. Breakpoints may be invalid because they are in 
a source location that does not produce code. This could be because they are in a section of code that 
was removed by the compiler or linker, or because the debugging information does not contain data for 
the address. In this case, disable the breakpoints. Then, add one breakpoint at a time to identify the 
invalid breakpoint. 

Deep Sleep Issue with cy_boot and GCC ARM Embedded v4.8.4 Toolchain 

Versions of the cy_boot component prior to v4.20 may exhibit a defect where PSoC 4100/PSoC 4200 
devices cannot wake from the Deep-Sleep state. It is recommended that you upgrade your cy_boot 
component version to v4.20. 

Access the Component Update Tool from the Project menu. 

Removing Older Components 
The following components were included in the PSoC Creator 1.0 release. Over time in various newer 
releases, these components have been updated with newer and better versions. Therefore, to reduce the 
installation size and time of PSoC Creator 3.1, these components have been removed from this and all 
future releases of PSoC Creator. If you need one or more of these components for your design, you can 
download them from www.cypress.com and import them using the PSoC Creator Import Component 
option (under the Project menu). 

Component Removed Version(s) Current Version 
ABuf 1.0 Deprecated 
ADC_DelSig 1.30, 2.0, 2.10 3.0 
ADC_SAR 1.10, 1.50 2.10 
ADC_Vssa 1.0 1.20 
AMux 1.20 1.80 
AMuxSeq 1.20 1.80 
BoostConv 1.10, 1.50 5.0 
CAN 1.30, 1.50 2.30 
CapSense_CSD 2.0, 2.10 3.40 
CharLCD 1.30, 1.40, 1.50 2.10 
Comp 1.10, 1.50 2.0 
Counter 1.20, 1.50 2.40 
CRC 1.20, 2.0 2.40 
cy_boot 2.21, 2.30 4.20 
cy_bufoe not specified 1.10 
cy_clock 1.0 2.20 
cy_dma 1.0 1.70 
cy_isr 1.0, 1.10, 1.20 1.70 
cy_lcd_port 1.0, 1.10 1.50 
cy_pins 1.10, 1.20 2.10 

http://www.cypress.com/
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Component Removed Version(s) Current Version 
cy_vref 1.0 1.60 
CyControlReg 0.5, 1.0, 1.50 1.80 
CyStatusReg 0.5, 1.0, 1.50 1.80 
DieTemp 1.10, 1.50 2.0 
EEPROM 1.50 2.10 
EZI2C 1.20, 1.50 1.90 
Filter 1.20, 1.50 2.20 
GraphicLCDCtrl 1.50, 1.60,  1.70 
GraphicLCDIntf 1.50, 1.60 1.70 
I2C 1.20 3.30 
I2S 1.0, 2.0, 2.10 2.60 
IDAC8 1.20, 1.50, 1.60 2.0 
LUT 1.0 1.50 
Mixer 1.10, 1.50, 1.60 2.0 
OpAmp 1.10, 1.50, 1.60 1.90 
PGA 1.20, 1.50, 1.60 2.0 
PGA_Inv 1.10, 1.50, 1.60 2.0 
PrISM 1.20, 1.50, 2.0 2.20 
PRS 1.30, 2.0 2.40 
PWM 1.10, 1.50 3.10 
QuadDec 1.20, 1.50 2.30 
RTC 1.20, 1.50 2.0 
SegLCD 2.0 3.40 
ShiftReg 1.20, 1.50 2.30 
SleepTimer 1.60 3.20 
SPI_Master 1.20, 2.0, 2.10 2.40 
SPI_Slave 1.20, 2.0, 2.10 2.60 
StaticSegLCD 1.30, 1.50 2.30 
TIA 1.10, 1.50, 1.60 2.0 
Timer 1.20, 1.50, 2.0 2.50 
UART 1.50 2.30 
USBFS 0.2, 1.50, 1.60 2.70 
VDAC8 1.20, 1.50, 1.60 1.90 
 

Supported Devices 
The design flow and tools available in PSoC Creator support the following PSoC 3 (CY8C3x), PSoC 4xxx 
(CY8C4x), PSoC 5LP (CY8C5x-LP), and PRoC BLE (CYBL10*). 

 Part Numbers 

PSoC 3 CY8C32* CY8C34* CY8C36* CY8C38*   

PSoC 4000 CY8C40*      

PSoC 4100/ CY8C41* CY8C42*     
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PSoC 4200 

PSoC 4100 BLE 
PSoC 4200 BLE 

CY8C41*BL CY8C42*BL     

PSoC 5LP CY8C52*LP CY8C54*LP CY8C56*LP CY8C58*LP   

PRoC BLE CYBL10*      

 

Supported Tool Chains 

Toolchains for PSoC 3 (8051) 

DP8051 Keil™ 9.51 

The Keil PK51 Professional Developers Kit for PSoC is installed with PSoC Creator. It supports 
optimization levels 0 through 5. If you would like to use the compiler optimization levels above level 5, you 
should purchase the standard PK51 product by contacting Keil. 
 In North, Central, or South America... sales.us@keil.com 
 In Europe, Asia, Africa, or Australia... sales.intl@keil.com 

The free Keil toolchain comes with a 30 day evaluation license. You can extend the license, without cost, 
by registering the product from within PSoC Creator (Help > Register > Keil…). Note that the extended 
license is for one year and that you will need to re-register it each year. 

DP8051 Keil Generic 

This option can be used to select a separately-installed version of the Keil toolchain. While any version 
can be selected, the only officially supported versions are 8.16, 9.03, and 9.51. 

Toolchains for PSoC 4 and PSoC 5LP (ARM) 
 ARM GCC 4.8.4 – The GCC ARM Embedded v4.8.4 toolchain is installed with PSoC Creator. It 

provides improved ARM code generation in DEBUG mode over v4.7.3. As of this release, v4.8.4 is 
the only ARM compiler provided with PSoC Creator; v4.7.3 has been removed. This toolchain has no 
use restrictions and does not require license activation (it is distributed under the terms of the GNU 
Public License). 

 ARM GCC Generic – This option can be used to select a separately-installed version of the ARM 
GCC toolchain. 

 ARM RVDS Generic – This option can be used to select a separately-installed version of the ARM 
RealView Development System. The officially supported versions are 4.0 (build 529) and 4.1 
(build 791). 

 ARM MDK Generic – This option can be used to select a separately-installed version of the ARM 
Microcontroller Development Kit. The officially supported versions are 4.0 (build 524) and 4.1 
(build 713). 

mailto:sales.us@keil.com
mailto:sales.intl@keil.com
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Installation 

Minimum and Recommended System Requirements 

The following are system requirements to install and use PSoC Creator. Each requirement specifies a 
minimum that your system must meet or exceed. 

PSoC Creator will execute correctly in highly resource-constrained systems. However, performance 
(startup time, project creation and opening, build times, and so on) may be impacted when resources are 
scarce. The most directly impacted performance metric is build time. The following sections provide 
examples of the resource scarcity impact. 

Note During initial startup, PSoC Creator builds and caches component DLL files used to display the 
component parameter editors. As a result, the tool will launch less quickly the first time after a new 
installation or a Windows® reboot. 

Summary 
Hardware/Operation System Requirements Minimum 

 Processor 1 GHz or faster 32-bit (x86) or Intel 
64/AMD64 64-bit  

 RAM 512 MB (1 GB preferred) 

 Free Hard Drive Space 5 GB 

 Screen Resolution 1024x768 

 USB 2.0 

 

Software Prerequisites * Minimum Version 

 Microsoft Internet Explorer (not IE8 beta) 7  

 .NET Framework 2.0 SP2  

 Adobe Reader (for viewing PDF Documentation) 9.2 **  

 Windows Installer 3.1  

 PSoC Programmer 3.22  

 Keil Compiler 8.16 (9.51 provided)  

* To install and run PSoC Creator, you may also need to install additional software. The Cypress Installer will 
guide you through the process if the additional programs are not already installed. 

** For Windows 7, the minimum required version of Adobe Reader is version 9.2. You can download the latest 
version here: http://get.adobe.com/reader/. You can also use a non-Adobe PDF reader if you prefer; however, 
Cypress has no recommendations for any particular non-Adobe reader or version. 

Processor 

1 GHz or faster 32-bit (x86) or Intel 64/AMD64 64-bit processor is required. 

PSoC Creator exhibits a predictable relationship between CPU speed and build time above 1 GHz. 
Doubling the CPU speed, e.g., from 1 GHz to 2 GHz or 1.5 GHz to 3 GHz, almost halves the build time. 

On a fast (3 GHz) PC, simple designs can build in about one minute. At low speeds even designs that fill 
the device and generate complex routing solutions will build in under 5 minutes. 

http://get.adobe.com/reader/
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Operating System 

One of the following Windows platforms is required: 
 Windows XP SP2 or SP3 (32-bit supported) 
 Windows Vista SP2 (32- and 64-bit supported) 
 Windows 7 and Windows 7 SP1 (32- and 64-bit supported) 
 Windows 8 and Windows 8.1 (32- and 64-bit supported) 
 Mac OS 10.9 on VMware Fusion 6 running Windows 8.1 
 Mac OS 10.9 on Parallels Desktop 9 running Windows 7 SP1 

Memory 

A minimum of 512 MB of RAM is required, but 1 GB is recommended. 

Note Cypress does extensive performance testing on every PSoC Creator release. The minimum RAM 
configuration used in these tests is 1 GB. No guarantees of system performance are given below 1 GB. 

With no other applications running, the minimum system configuration will ensure that the tool launches 
quickly, creates and opens projects in a few seconds, and responds to user input without feeling sluggish. 

System RAM has the most direct impact on PSoC Creator build times. The following chart shows how 
insufficient RAM (i.e., below 512 MB) causes an excessive increase in build time, even for "empty" 
designs. 

0

100

200

300

400

500

600

700

256 512 768 1024

Complex Design

Simple Design

 

The graph shows that performance is heavily degraded below the threshold where memory paging is 
required but extra memory above that level does not generate a significant improvement. 

Free Disk Space 

PSoC Creator requires 5 GB of free disk space. PSoC Creator will install and run with just 1 GB of free 
disk space. However, in order to allow Windows to do memory paging, we recommend a minimum free 
disk space requirement of 5 GB. 

If your disk is highly fragmented it will severely impact memory paging time and can result in very long 
build times. Disks that are nearly full are particularly prone to fragmentation. We recommend de-
fragmenting your disk if you experience excessively long build times (10 minutes or more). 
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USB 

PSoC Creator requires a USB 2.0-compliant host to program and debug. 

Screen 

A resolution of 1024x768 pixels or higher is required. 

Note The build time examples given above were obtained with new product installations on minimally 
fragmented disks with no other applications running. If your build times exceed these expectations we 
recommend closing unnecessary applications, adding RAM to the system (to reduce paging) and 
ensuring that there is sufficient free and unfragmented disk space. 

Software Update Instructions 

As part of the installation process, the Cypress Update Manager utility will also be installed and located 
on the Start menu. You can use this utility to update all Cypress programs you have installed when 
updates for them become available. 

Open Source 

Portions of this software package are licensed under free and/or open source licenses such as the GNU 
General Public License. Such free and/or open source software is subject to the applicable license 
agreement and not the Cypress license agreement covering this software package. The applicable 
license terms will accompany each source code package. You may obtain the source code of such free 
and/or open source software at no charge from the following web site: www.cypress.com/go/opensource. 

Installation Notes 

The installation process is a set of wizards that walk you through installing various components. You can 
install PSoC Creator and various prerequisites from the web or from a DVD. There are slight differences 
in the process based on the medium used to install the software. 

The DVDs provide the necessary prerequisites and the wizards to guide you through installing the 
appropriate software. The following sections contain more specific installation details. 

Note Do NOT plug in your Miniprog3 until all software installation is complete AND the PSoC Creator 
application has been opened. 

PSoC Creator DVD Installation 

The PSoC Creator DVD contains PSoC Creator and PSoC Programmer, as well as various prerequisites.  

1. Load the DVD. The main installer program should run automatically. If not, double-click the 
cyautorun.exe file to launch it. 

2. On the main installer, click the Install Software for PSoC… button to launch the PSoC Creator 
InstallShield Wizard. 

3. Follow the prompts on the wizard. The CyInstaller for PSoC Creator opens and displays steps to 
install PSoC Creator.  

4. Click the hyperlink for any software that is not installed as indicated (such as, Acrobat Reader, 
etc.). Run the installer for that program as needed. 

5. Continue following the prompts to install PSoC Creator. 

http://www.cypress.com/go/opensource


  
PSoC® Creator™ Release Notes 
Version 3.1, Component Pack 1 

January 31, 2015  - 12 - 

Cypress PSoC Kit DVD Installation 

A kit DVD contains PSoC Creator and PSoC Programmer, as well as projects, documentation, and 
prerequisites needed for the associated kit. Refer to kit instructions. 

Web Installation 

If you are downloading the software from the web (www.cypress.com/creator), run the PSoC Creator 
single package executable. 

1. Double-click the PSoC Creator executable file to launch the installer. 

2. If a non-Cypress prerequisite is missing (like .Net and Windows Installer, etc), a webpage with a 
download link will pop up. Download and install the prerequisites. Run the installer of those 
programs as needed. 

3. Follow the prompts to install PSoC Creator. The CyInstaller for PSoC Creator opens and displays 
a series of steps to install PSoC Creator, and it will perform pre-requisite checks and install the 
prerequisites. 

4. When complete, close the installer. 

Further Reading 
The primary documentation for PSoC Creator is provided in the Help, which you can open from the Help 
menu or by pressing [F1]. Other documents included with this release are also available from the Help 
menu, under Documentation. These documents include (but are not limited to): 
 Quick Start Guide 
 System Reference Guide 
 Component Author Guide 

Cypress provides a web page specifically for PSoC Creator at www.cypress.com/creator. You can also 
find more documentation using the Cypress Document Manager (CDM) tool, which is available for 
download from the Cypress web site at www.cypress.com/cypressdocumentmanager. 

Other documentation includes (but is not limited to): 
 Device Datasheets 
 Device Architecture Technical Reference Manual (TRM) 
 Device Registers TRM 
 Migration Guides 
 Application Notes 
 Training 

Contact your Cypress representative, as needed. 

 

http://www.cypress.com/creator
http://www.cypress.com/creator
http://www.cypress.com/cypressdocumentmanager/
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Defects Fixed 

The following customer-reported defects were fixed in this release. These defects are separated into 
different categories. 

Bootloading 

Cypress 
ID 

Defect  Fix and Impact 

176522 Bootloadable projects fail to build 
when the associated bootloader 
project's ELF file is read-only. 

PSoC Creator was attempting to open the files as read-write. 
This is unnecessary and now the file open process is done read-
only and the projects build as expected. 

193224 Bootloader Host Tool fails to detect 
the COM port of the CY8CKIT-049 
kit's USB-Serial bridge on non-English 
installations of Windows. 

The serial port enumerates correctly and has a COM port 
number assigned, but it is not displayed in the Bootloader Host 
Tool. The code to detect serial channels was updated to better 
address kit connection/disconnection. Bootloading should be 
more reliable on all Windows installations. 

 

Build System 

Cypress 
ID 

Defect  Fix and Impact 

168656 The XTAL clock, on PSoC 3 and 
PSoC 5LP devices, fails to start when 
there is a pin in that port configured to 
be resistive pull-down on reset. Note 
that this applies only to the reset state 
of the pin, not its run-time 
configuration. 

During system start-up, the routing connections were being 
made before the pins were set up. As a result, the port to which 
the XTAL was connected was in its pull-down reset state, and 
the clock could not start (at reset all pins in the port were pulled 
down). Now, when XTAL is enabled, the pins on the port are set 
up to their (per-pin, not per-port) run-time values before starting 
the clock. The XTAL clock will now start even if there is a pin in 
its port configured to be resistive pull-down on reset. 

170697 Segment LCD pin selections for 
commons and segments are limited 
when CapSense is also resident in the 
design. The tool reports   "E2725: 
P3[6] cannot be used as an output 
when P4[2] is configured as Cmod". 

The CapSense Component uses pins p4.2 and P4.3 for the 
CMOD and CTANK signals. When either pin is in use, it is not 
possible to route general (for example, UDB-based) signals to 
P3.6 or P3.7. However, the Segment LCD has direct (non-DSI) 
connections to those pains and so they should be available. 
PSoC Creator now correctly enables the connection of common 
and segment signals to those pins and the error message is not 
displayed. 

172429 With "Quiet Output" disabled for 
synthesis (Build Settings dialog > 
Code Generation) the messages in 
the Output Window are truncated to 
80 characters. 

The message buffer was enlarged to ensure that the full path 
names of Verilog files can be printed without truncation. 

176717 Projects that use DMA to configure the 
device issue the error: "Variable 
'DMA_ZERO_VAL' set but not used [-
Wunused-but-set-variable]". 

Projects that use DMA to configure the device, but do not use 
DMA in the actual application, include the code in the 
cyfitter_cfg.c file. However, these projects have no need for the 
DMA_ZERO_VAL variable. The build tools now check if the 
variable is going to be needed before generating the code. The 
error message is no longer printed. 
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Cypress 
ID 

Defect  Fix and Impact 

180593 IDAC or OpAmp outputs on p1.0 are 
tied to 0 V on some PSoC 4 devices.  

When the SAR ADC is configured to use "Internal 1.024 V 
bypassed" as the reference signal, PSoC Creator uses P1.5 for 
the bypass. On some devices, however, this pin is not bonded 
out on the package and so the PSoC Creator did not generate 
the code to close its switch. The implemented solution "fakes" 
the presence of the pin, which enables the generation of the 
code to close the switch. IDAC and Opamp outputs on P1.0 now 
work correctly, even on devices where the ADC bypass pin is 
used but not bonded out. 

184166 When multiple PICU interrupts of type 
"Rising Edge" are included in the 
design, PSoC Creator reported the 
following error: "E1217-Failed to route 
all nets; unable to resove overuse". 

The error message is correct because PSoC Creator has located 
the interrupts to adjacent interrupt locations (in the vector table). 
It is not possible to route that design because the interrupts 
share a common DSI connection. The fitter algorithm has been 
updated to re-route the interrupts to locations that do not share 
the DSI connection and the message no longer occurs. 

187022 The Project Datasheet generated by 
PSoC Creator lists P3[2] and P3[3] 
(for PSoC 4) as unused GPIOs in 
section 2.1: Hardware Pins, while 
actually they are used for Debug 
(SWD). 

This issue applies to all devices, not just PSoC 4. It was fixed 
along with a numer of other datasheet-generation errors. 

 

Debugging/Programming 

Cypress 
ID 

Defect  Fix and Impact 

148803 When more than one PSoC 4 device 
is available (connected via USB 
ports), the Select Debug Target dialog 
does not allow switching between two 
PSoC 4 devices. There is no way to 
change the target without removing 
the currently-selected device. 

The Select Debug Target dialog did not report the correct device 
ID when switching between two PSoC 4 devices. Instead, it 
continually reported the old device. This was corrected by forcing 
an enumeration of devices when the dialog is opened. It is now 
possible to change the target device from the dialog wihout 
unplugging the debugger. 

157752 It is not easy to program a blank 
PSoC 4 device. The device does not 
get displayed correctly in the Select 
Debug Target dialog unless the user 
does a "Port Acquire." 

The issue occurred when the device was cleared by an "Erase 
All" procedure in PSoC Programmer. The Select Debug Target 
now automatically performs a Port Acquire when it does not 
recognize a device. 

174710 Debugger reports 64-bit values as 
zero, regardless of the actual value. 

Corrected the handling of "long long int" and "uint64" data types. 
Also corrected handling of "volatile" variables. 

183354 Breakpoints cannot be placed in 
source code when the preceding code 
is collapsed in the text editor. 

When the popup menu was used to insert breakpoints, there was 
a problem when the code just above the target line was 
collapsed. The breakpoint was placed in collapsed code, not on 
the required line. Fixes to the editor ensure that it returns the 
correct document location and the breakpoint goes in the 
expected location. 

187799 The StepOver command halts 
execution on the wrong line of code 
when the project is built with GCC. 

The defect was in the debugging information generated by the 
GNU linker. The shipped GNU compiler toolchain was updated 
to v4.8.4 and the linker error is no longer present in that release. 
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Framework 

Cypress 
ID 

Defect  Fix and Impact 

178708 F3 shortcut fails to "Find Next". When a search has been run, the "Find Next" button worked as 
expected but the F3 shortcut did not. The shortcut has now been 
implemented and strings may be repeatedly searched without 
accessing the dialog. 

185932 The symbol generated from the 
Symbol Wizard causes errors about 
analog input terminals. 

This is a legacy issue from very early versions of PSoC Creator 
(prior to the first public 1.0 release) that supported direction on 
analog pins. The Symbol Wizard code contained a typing error 
("input" versus "inout") that caused a bad terminal type to be 
inserted for all analog terminals. That error has been corrected 
and the wizard now correctly generates non-directional analog 
terminals. 

188707 PSoC Creator's Ohm Meter tool 
shows incorrect values for dedicated 
routes (compared with measured 
values). 

The Ohm Meter tool erroneously reported 300 Ohms and 2000 
Ohms in the routing paths from internal reference to pins P3[7] 
and P0[4] respectively on PSoC 5LP devices. The actual routing 
resistance along that path is ~20-30 Ohms. The error was in the 
opamp input switch resistance, which was being incorrectly 
added to the reported resistance. The reported value is now 0 
Ohms, which is slightly low but within reported accuracy. 

 

System 

Cypress 
ID 

Defect  Fix and Impact 

188928 Writing to the most significant byte of 
a packed volatile structs fails with the 
GNU compiler. 

The defect was in the GNU compiler The shipped GNU compiler 
toolchain was updated to v4.8.4 and the error is no longer 
present in that release. 

191130 PSoC device CY8C3245LTI-129 is 
listed in the Device Selector but not in 
the family datasheet. 

The device never actually existed. It has been removed from the 
Device Selector. Projects targeting the device will prompt for a 
new selection when opened in PSoC Creator 3.1. 

194455 The device family datasheet for PSoC 
device CY8C5888LTI-LP097 lists 
support for CAN 2.0b but projects 
targeting that device fail when CAN is 
added to the design. 

The device database was updated to correct the definition of 
CY8C5888LTI-LP097. Designs can now support the CAN 
component. 

 

BLE Component 

Cypress 
ID 

Defect  Fix and Impact 

202141 On some devices the BLE RF link 
(transmit/receive) was unreliable. The 
device would fail to advertise in all 
channels and, if a connection was 
made, it might fail to communicate in 
some RF channels. 

The failures are due to frequency deviation in the radio caused 
by an incorrect voltage setting on the RF PLL feedback LDO. 
The new component version (v1.10) addresses the voltage 
setting and ensures connections can be reliably made and 
maintained. 



  
PSoC® Creator™ Release Notes 
Version 3.1, Component Pack 1 

January 31, 2015  - 16 - 

 
Cypress Semiconductor 

198 Champion Ct. 
San Jose, CA 95134-1709 USA 

Tel: 408.943.2600 
Fax: 408.943.4730 

Application Support Hotline: 425.787.4814 
www.cypress.com 

© Cypress Semiconductor Corporation, 2015. All rights reserved. 

The information contained herein is subject to change without notice. Cypress Semiconductor Corporation assumes no responsibility for the use of 
any circuitry other than circuitry embodied in a Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress 
products are not warranted nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an 
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components in life-support 
systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress products in 
life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.  

PSoC® and CapSense® are registered trademarks, and Programmable System-on-Chip™, PSoC Creator™, and SmartSense™ are trademarks of 
Cypress Semiconductor Corporation. All other trademarks or registered trademarks referenced herein are property of the respective corporations. 

This Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by and subject to 
worldwide patent protection (United States and foreign), United States copyright laws and international treaty provisions. Cypress hereby grants to 
licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create derivative works of, and compile the Cypress Source Code 
and derivative works for the sole purpose of creating custom software and or firmware in support of licensee product to be used only in conjunction 
with a Cypress integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation 
of this Source Code except as specified above is prohibited without the express written permission of Cypress.  

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Cypress 
reserves the right to make changes without further notice to the materials described herein. Cypress does not assume any liability arising out of the 
application or use of any product or circuit described herein. Cypress does not authorize its products for use as critical components in life-support 
systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a 
life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.  

Use may be limited by and subject to the applicable Cypress software license agreement. 

 

http://www.cypress.com/

	Contents
	PSoC Creator 3.1 Component Pack 1 Contents
	New Features in PSoC Creator 3.1
	BLE Part Support
	Updated Code Editor
	Superset Part Programming
	Static Library Support for Components
	Project "Save As" Capability
	Updated Rubber-Banding

	Components and Example Projects
	New Component
	Updated Components
	Updated Example Projects

	Design Impact
	Changed Internal Low Speed Oscillator (ILO) Accuracy in PSoC 4100 and PSoC 4200 devices
	Watch Dog Timer (WDT) Usage in BLE Component
	Corrected heap bounds-checking in sbrk()
	Default Stack and Heap Sizes
	Stepping Over Flash Write Functions
	Debugger Breakpoint Failure on GCC ARM Embedded v4.8.4 Toolchain
	Deep Sleep Issue with cy_boot and GCC ARM Embedded v4.8.4 Toolchain
	Removing Older Components

	Supported Devices
	Supported Tool Chains
	Toolchains for PSoC 3 (8051)
	DP8051 Keil™ 9.51
	DP8051 Keil Generic

	Toolchains for PSoC 4 and PSoC 5LP (ARM)

	Installation
	Minimum and Recommended System Requirements
	Summary
	Processor
	Operating System
	Memory
	Free Disk Space
	USB
	Screen

	Software Update Instructions
	Open Source
	Installation Notes
	PSoC Creator DVD Installation
	Cypress PSoC Kit DVD Installation
	Web Installation


	Further Reading
	Defects Fixed
	Bootloading
	Build System
	Debugging/Programming
	Framework
	System
	BLE Component


